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What is Computational fluid dynamics? 

 Computational fluid dynamics, usually abbreviated as CFD, is a branch of fluid 

mechanics that uses numerical methods and algorithms to solve and analyze problems that 

involve fluid flows. Computers are used to perform the calculations required to simulate the 

interaction of liquids and gases with surfaces defined by boundary conditions. With high-

speed supercomputers, better solutions can be achieved. Ongoing research yields software 

that improves the accuracy and speed of complex simulation scenarios such 

as  transonic or turbulent flows. Initial experimental validation of such software is performed 

using a wind tunnel with the final validation coming in full-scale testing, e.g. flight tests. 

Experiments vs. Simulations 

 CFD gives an insight into flow patterns that are difficult, expensive or impossible to 

study using traditional (experimental) techniques 

Experiments Simulations 

Quantitative description of flow phenomena 

using measurements 

   • for one quantity at a time 

   • at a limited number of points and time   

     instants 

   • for a laboratory-scale model 

   • for a limited range of problems and  

     operating conditions 

Error sources: measurement errors, flow 

disturbances by the probes 

Quantitative prediction of flow phenomena 

using CFD software 

   • for all desired quantities 

   • with high resolution in space and time 

   • for the actual flow domain 

   • for virtually any problem and realistic  

     operating conditions 

Error sources: modeling, discretization, 

iteration, implementation 

 As a rule, CFD does not replace the measurements completely but the amount of 

experimentation and the overall cost can be significantly reduced. 

Experiments Simulations 
Equipment and personnel 

are difficult to transport 

CFD software is portable, 

easy to use and modify 

• expensive 

• slow 

• sequential 

• single-purpose 

• cheap(er) 

• fast(er) 

• parallel 

• multiple-purpose 
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The results of a CFD simulation are never 100% reliable because 

• the input data may involve too much guessing or imprecision 

• the mathematical model of the problem at hand may be inadequate 

• the accuracy of the results is limited by the available computing power 

CFD - how it works 

• Analysis begins with a mathematical model of a physical problem. 

• Conservation of matter, momentum, and energy must be satisfied throughout the 

region of interest. 

• Fluid properties are modeled empirically. 

• Simplifying assumptions are made in order to make the problem tractable (e.g., 

steady-state, incompressible, inviscid, two-dimensional). 

• Provide appropriate initial and boundary conditions for the problem. 

• CFD applies numerical methods (called discretization) to develop approximations of 

the governing equations of fluid mechanics in the fluid region of interest. 

- Governing differential equations: algebraic. 

- The collection of cells is called the grid.  

- The set of algebraic equations are solved numerically (on a computer) for 

the flow field variables at each node or cell. 

- System of equations are solved simultaneously to provide solution. 

- The solution is post-processed to extract quantities of interest (e.g. lift, drag, 

torque, heat transfer, separation, pressure loss, etc.) 
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• Grid Modeling 

   - Numerical formula 

   - Set boundary regions 

   - Governing equations 

   - 3D/2D modeling 

   - Generation of grid 

• Solve the governing 

equations 

   - Set Boundary conditions 

   - Matrix Solving 

   - Convergence Criterion 

   - Steady or Unsteady 

• Visualization & Animation 

   - Velocity 

   - Pressure 

   - Temperature 

   - Flow path 

 

 
PDE 

(Governing Equations) 
 

Discretization 
 

Algebraic Equations 
(+  -  ×  ÷) 

 

 

Applications of CFD 

Biomechanics 

Pre-processing Solving Post-processing 
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Electronics 

    
Sport and Recreation 

 

 Environmental Engineering  
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Automotive Engineering and Aeronautical Engineering 

 
Civil Engineering 

 
Agricultural Engineering 
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Student Project 

 
Flow around A380 Airplane 

 Simulation of Turbulent compressible flow around the bullet trains 

  This project is to study the simulation and analysis of the aerodynamics behavior of 

turbulent flow around the head coach of bullet train with normal and kingfisher design, 

under the condition of compressibility flow. this project is to study speed at 300 and 500 
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km/hr. the tunnel size of 6.4m and eight train bogies are investigated in simulation. the 

project operational were analyzed by means of CFD method. The initial, create the head 

coach of bullet train by using SolidWorks 2013 program. Then simulation and analysis of fluid 

dynamics using Ansys Fluent 14.0 program. the results showed that a original coach have 

pressure darg more than a kingfisher coach. and shear forces acting on the front coach of the 

kingfisher can reduce the shear forces acting on the front coach down. and a maximum 

pressure occurs at the front of the kingfisher coach can reduce which a kingfisher coach 

through quiet sound to tunnel. and so causes a kingfish coach better original coach. 

 
Flyak 

The boating “Speed” is important. Such as Kayaking, one of the variables that affect 

the speed of kayaking is drag force .Drag force arises partly from the surface of the kayak and 

water. Reduction between surface of the kayak and water is one of choice to reduce drag 

force with Lift force from Hydrofoil .Hydrofoil will install under kayak for generate lift force to 

rise kayak floating up water surface. This project is a study of simulation and analysis of the 

kayak was equipped with hydrofoil. The objectives want to design about size and location of 
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the hydrofoil for install on kayak. And to see about the behavior of water flow through the 

kayak. Comparison between the drag coefficient of kayak without hydrofoil and kayak is 

equipped with hydrofoil. The simulation and analysis of fluid dynamics using Ansys Fluent 

12.0 program by velocity of flow is 5.5 meters per second ,type of hydrofoil using the 

NACA0012 and choose the angle of attack is 8 degree because at this angle give lift force 

enough to floating up kayak from water surface. From result of simulation, drag force of 

kayak is equipped with hydrofoil has drag force less than kayak without hydrofoil. And from 

this result showed drag force can reduce from the surface of the kayak and water by this 

method. In addition of drag force from the surface of the kayak and water ,A drag force are 

not considered in the simulation and analysis of fluid dynamics with Ansys Fluent 12.0. That 

is one of drag force from wave drag. If other project will study about simulation of kayak or 

boat, drag force from wave will should be taken into consideration. 

Introduction to ANSYS Workbench 

Welcome to the world of Computer Aided Engineering (CAE) with ANSYS Workbench. 

If you are a new user, you will be joining hands with thousands of users of this Finite 

Element Analysis software package. If you are familiar with the previous releases of this 

software, you will be able to upgrade your designing skills with tremendous improvement in 

this latest release. 

 System Requirements 

The following are minimum system requirements to ensure smooth functioning of ANSYS 

Workbench on your system: 

- Operating System: Windows 64-bit (Windows XP 64 SP2, Windows Vista 64 SP1, 

Windows7, Windows HPC Server 2008 R2), Windows 32-bit (Windows XP SP2, 

Windows Vista SP1, Windows 7) 

- Platform: Intel Pentium class, Intel 64 or AMD 64. 

- Memory: 1 GB of RAM for all applications, 2GB for running CFX and FLUENT. 

- Graphics adapter: Should be capable of supporting 1024x768 High Color (16-bit). 
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 Starting ANSYS Workbench 14.0 

Step 1: Creating a FLUENT Fluid Flow Analysis System in ANSYS Workbench 

In this step, you will start ANSYS Workbench, create a new FLUENT fluid flow analysis 

system, then review the list of files generated by ANSYS Workbench. 

1. Start ANSYS Workbench by clicking the Windows Start menu, then selecting the 

Workbench 14.0 option in the ANSYS 14.0 program group. 

Start  All Programs  ANSYS 14.0  Workbench 14.0 

 

 
Start ANSYS Workbench 

 
ANSYS Workbench 
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The Workbench window along with the Getting Started window 

The Workbench window helps streamline an entire project to be carried out in 

ANSYS Workbench 14.0. In this window, one can create, manage, and view the workflow of 

the entire project created by using standard analysis systems. The Workbench window 

mainly consists of Menu bar, Standard toolbar, the Toolbox window, Project Schematic 

window, and the Status bar. 

 
The components of the Workbench window 

Titlebar 
MenuBar 
Standard toolbar 
Project Schematic window 

Status bar 

Toolboxes 
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Toolbox Window 

The Toolbox window is located on the left in the Workbench window. The 

Toolbox window lists the standard and customized templates or the individual analysis 

components that are used to create projects. To create a project, drag a particular analysis 

or component system from the Toolbox window and drop it into the Project Schematic 

window. Alternatively, double-click on a particular analysis or component system in the 

Toolbox window to add it to the Project Schematic window and to create the project. 

 
Analysis Systems, Component Systems, Custom Systems, and Design Exploration. 

 Pre-Processing 

Working on a New Project. 

To start working on a new project, you need to add an appropriate analysis or 

component system to the Project Schematic window. 
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2. Create a new FLUENT fluid flow analysis system by double-clicking the Fluid 

Flow (FLUENT) option under Analysis Systems in the Toolbox. 

 

 Tip 

 can also drag-and-drop the analysis system into the Project Schematic. A green 

dotted outline indicating a potential You location for the new system initially appears in the 

Project Schematic. When you drag the system to one of the outlines, it turns into a red box 

to indicate the chosen location of the new system. 

 
ANSYS Workbench with a New FLUENT-Based Fluid Flow Analysis System 

 3. Setting geometry properties by right-clicking on geometry and then change 

Analysis Type from 3D to 2D(if you want to use 2D Analysis) 
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Setting geometry properties  

 Step 1 : Creating the Geometry in ANSYS DesignModeler 

 For the geometry of your fluid flow analysis, you can create a geometry in ANSYS 

DesignModeler, or import the appropriate geometry file. In this step, you will create the 

geometry in ANSYS DesignModeler, then review the list of files generated by ANSYS 

Workbench. 

 1. Start ANSYS DesignModeler. In the ANSYS Workbench Project Schematic, 

double-click the Geometry 

  

 Tip 

 You can also right-click the Geometry cell to display the context menu, then select 

New Geometry 
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The DesignModeler window 

 Sketching Mode 

 The Sketching mode is used to draw 2D sketches. Later on, these sketches can be 

converted into 3D models using the Modeling mode.  

 Modeling Mode 

 The Modeling mode is used to generate the part model using the sketches drawn in 

the Sketching mode.  

                        
             The Sketching Toolboxes window                The Tree Outline 

Title bar Menu bar 

Tree Outline 

Sketching tab 

Modeling tab 

Model View tab 

 Print Preview tab 

Ruler 

Status bar 

Triad 
ISO ball 
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 2. Set the units in ANSYS DesignModeler 

 When ANSYS DesignModeler first appears, you are prompted to select the desired 

system of length units to work from. You can chose meters and press ok. 

 
Setting the Units in ANSYS DesignModeler. 

 3. Click the XYPlane in the Tree Outline, this means that we will use the X-Y plane 

to draw 2D geometry.  

        

and then click the blue z-axis at the bottom-right corner of the Graphics window to get front 

view of the X-Y plane 

 

Click the Sketching tab below the Tree Outline box, and select Settings in the Sketching 

Toolboxes. select Grid, and enable the Show in 2D and the Snap options. 
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Next you can Create Geometry  

2D-Geometry 

 
To creating the geometry with ANSYS DesignModeler, the steps are following: 

 1. Creating line. 

Now the canvas is ready for us to sketch our geometry. Click the Draw menu in the Sketching 

Toolboxes, and then select Rectangle. 
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Rectangle on Sketching Toolbox 

 Now you can draw the Rectangle by first clicking on the coordinate origin, and then 

move the cursor oblique to create Rectangle (1x1 m). You can setting dimension by select 

Dimensions on Sketching Toolbox. 

 

 2. Creating Surface. 

 Now we create a surface body Click Concept  Surfaces From Sketches. 

 

 Select the Base Objects to Sketch1 (4 line), and click Apply. 
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 And then click Generate button above the Graphics window. 

 
2D Geometry 

 Step 2 : Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 
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ANSYS Meshing  

 Tip 

 You can double-clicking the Mesh menu in the Project Schematic window to open 

ANSYS Meshing. 

 

that the geometry we just created is automatically loaded. 

 
The ANSYS Meshing Application with the 2D Geometry Loaded 
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 Mesh Edge 

 STEPS : 

 1. Set some basic meshing parameters for the ANSYS Meshing application : Then 

using edge selector  and right clicking InsertSizing 

 

 2. Mesh Edges 

 

 In the Outline Details of "Edge Sizing"-SizingTypeNumber of Divisions20 
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3. Repeat the process for the rest edges. 

 

 Mesh Face 

 

 STEPS : 

 Now you can create Mesh by right clicking Mesh in Outline Box select Generate 

Mesh or click Generate Mesh on Menu bar . 

   

Mesh 
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 Uniform Meshing 

 STEPS: 

 1. Back to the step of Mesh Edge process. 

 2. At Mesh EdgesBias TypeBias Factor : 5 

 

 3. Repeat the process for the rest Edge with the same value of the Bias Factor. 

 

 4A. Right click on Mesh inOutline box Select InsertMethod 

  ●Details of "Automatic Method"-Method dialog box  

   Select Geometry and click Apply. 

   Method : Uniform Quad 

   Element Size : 1 
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 5A. Now you can create Mesh by right clicking Mesh in Outline Box select Generate 

Mesh or click Generate Mesh on Menu bar . 

 

Unstructured Meshing 

 4B. Right click on Mesh inOutline box Select InsertMethod 

  ●Details of "Automatic Method"-Method dialog box  

   Select Geometry and click Apply. 

   Method : Triangles 

 5B. Now you can create Mesh by right clicking Mesh in Outline Box select Generate 

Mesh or click Generate Mesh on Menu bar . 
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 Step 3 : Create named selections for the geometry boundaries. 

 Create named selections for the geometry boundaries : Right-click the top edge and 

select the Create Named Selection option. In the Selection Name dialog box, enter Moving 

wall for the name and click OK.  

 Perform the same operations for:  lift, Right and bottom edge  enter wall for the 

name and click OK.  

   
Create named selections for the geometry boundaries 

 Using the Generate Mesh option creates the mesh, but does not actually create 

the relevant mesh files for the project and is optional if you already know that the mesh is 

acceptable. Using the Update option automatically generates the mesh, creates the relevant 

mesh files for your project, and updates the ANSYS Workbench cell that references this 

mesh. 

 

 
Dinosaur mesh 
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Solving with Ansys Fluent 

 Step 4 : Setting Up the CFD Simulation in ANSYS FLUENT 

 Now that you have created a computational mesh for the 2D geometry, in this step 

you will set up a CFD analysis using ANSYS FLUENT, then review the list of files generated 

by ANSYS Workbench.  

 Start ANSYS FLUENT : In the ANSYS Workbench Project Schematic, double-click the 

Setup cell in the 2D fluid flow analysis system. You can also right-click the Setup cell to 

display the context menu where you can select the Edit... option. 

 
Setup 

 
 When ANSYS FLUENT is first started, the FLUENT Launcher is displayed, enabling you 

to view and/or set certain ANSYS FLUENT start-up options. 

 
FLUENT Launcher display 
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 That the Dimension setting is already filled in and cannot be changed, since ANSYS 

FLUENT automatically sets it based on the mesh or geometry for the current system. 

 - Make sure that Serial from the Processing Options list is enabled. 

 - Make sure that the Display Mesh After Reading, Embed Graphics Windows, and 

Workbench Color Scheme options are enabled. 

 - Make sure that the Double Precision option is disabled. 

Click OK to launch ANSYS FLUENT. 

The mesh is automatically loaded and displayed in the graphics window by default 

 
The ANSYS FLUENT Application 

3.1. General settings for the CFD analysis. 
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 That the ANSYS Meshing application automatically converts and exports meshes for 

ANSYS FLUENT using meters (m) as the unit of length regardless of what units were used to 

create them. This is so you do not have to scale the mesh in ANSYS FLUENT under ANSYS 

Workbench. 

 Check the mesh. 

 General  Check 

 ANSYS FLUENT will report the results of the mesh check in the console. 
 Domain Extents: 
     x-coordinate: min (m) = 0.000000e+00, max (m) = 1.000000e+00 
     y-coordinate: min (m) = 0.000000e+00, max (m) = 1.000000e+00 
  Volume statistics: 
     minimum volume (m3): 6.249988e-04 
     maximum volume (m3): 6.250018e-04 
      total volume (m3): 1.000000e+00 
 Face area statistics: 
     minimum face area (m2): 2.499998e-02 
     maximum face area (m2): 2.500004e-02 
  Checking mesh......................... 
 Done. 

 The minimum and maximum values may vary slightly when running on different 

platforms. The mesh check will list the minimum and maximum x and y values from the 

mesh in the default SI unit of meters. It will also report a number of other mesh features 

that are checked. Any errors in the mesh will be reported at this time. Ensure that the 

minimum volume is not negative as ANSYS FLUENT cannot begin a calculation when this is 

the case. 

3.2. Models for the CFD simulation. 

 
Models 
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3.3. Materials for the CFD simulation. 

 

                                                    
The Create/Edit Materials Dialog Box 

3.4. Boundary conditions for the CFD analysis. 
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3.5. Solution parameters for the CFD simulation. 

       
Solution Methods and Solution Controls 

 ● MonitorsResiduals 

    
Monitors 

 ● Solution InitializationInitialize 
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Step 4: Run Calculation 

  

Post-processing 

 Graphics and Animations 

     
 

     
Velocity vectors around a dinosaur 
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Pressure field on a dinosaur 

 

 
 

 
Velocity magnitude (0-6 m/s) on a dinosaur 
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Analysis of 2-D FLOW 

 
 

 Driven Cavity Flow 

 

 Channel Flow 

 
 

 Backward Facing Step Flow 

 
 

 Flow around a Cylinder 

 
 

 Flow around an Airfoil 

 

 Unsteady Flow Simulation 

 Flow around a Cylinder 
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                Cavity Flow 

 

 

 

 

 

 

 

 Case A1 : Driven Cavity Flow 

Problem Specification 

Specification: 

- Fluid flow inside a 1x1 m^2 square cavity 

as shown in the figure 

- Upper wall moving with a constant velocity 

of U=1 m/s 

- The Reynolds number based on the cavity 

height can be calculated from 

 Re= ρUH/μ 

If μ is set with a constant value, say 1, 

Reynolds number is therefore varied with 

respect to ρ. For example,  

Re=100 is obtained by setting ρ=100, μ=1. 

  

 Determine the u- and v-velocity at 

positions of y- and x-midplanes, respectively, 

and then compare the results with reference 

data (Ghai et al, 1985) to assess the accuracy 

at various Reynolds numbers of 100, 400, 

1000, 3200, and 5000. 

 

 

 

 

 

 

 

 

 

 

 

Moving wall : U 

H=1 

L=1 

Fixed wall 
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1. Open New Project. 

To start working on a new project, you need to add an appropriate analysis or 

component system to the Project Schematic window. 

1.1 Create a new FLUENT fluid flow analysis system by double-clicking the Fluid 

Flow (FLUENT) option under Analysis Systems in the Toolbox.  

 

1.2 Setting geometry properties by right-clicking on geometry and then change Analysis Type 

from 3D to 2D(if you want to use 2D Analysis) 

 
Setting geometry properties  
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 2. Creating Geometry 

 Start ANSYS DesignModeler. In the ANSYS Workbench Project Schematic, double-

click the Geometry,  

 

 Now the canvas is ready for us to sketch our geometry. Click the Draw menu in the 

Sketching Toolboxes, and then select Rectangle. 

 
Rectangle on Sketching Toolbox 

 Now you can draw the Rectangle by first clicking on the coordinate origin, and then 

move the cursor oblique to create Rectangle (1x1 m). You can setting dimension by select 

Dimensions on Sketching Toolbox. 
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create Rectangle (1x1 m2). 

Now we create a surface body Click Concept  Surfaces From Sketches. 

 

Select the Base Objects to Sketch1, and click Apply. (4 line) 
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And then click Generate button above the Graphics window. 

 
2D Geometry 

 3. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 
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ANSYS Meshing  

 Tip 

 You can double-clicking the Mesh menu in the Project Schematic window to open 

ANSYS Meshing. 

 

that the geometry we just created is automatically loaded. 

 
The ANSYS Meshing Application with the 2D Geometry Loaded 

 Set some basic meshing parameters for the ANSYS Meshing application : Then using 

edge selector  Press Ctrl on keyboard select all edge and right clicking InsertSizing 
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In the Outline Details of "Edge Sizing"-SizingTypeNumber of Divisions40 

   

 Now you can create Mesh by right clicking Mesh in Outline Box select Generate 

Mesh or click Generate Mesh on Menu bar . 

   

Mesh 
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 Create named selections for the geometry boundaries : Right-click the top edge and 

select the Create Named Selection option. In the Selection Name dialog box, enter Moving 

wall for the name and click OK.  

 Perform the same operations for:  lift, Right and bottom edge  enter wall for the 

name and click OK.  

   
Create named selections for the geometry boundaries 

 

 Using the Generate Mesh option creates the mesh, but does not actually create 

the relevant mesh files for the project and is optional if you already know that the mesh is 

acceptable. Using the Update option automatically generates the mesh, creates the relevant 

mesh files for your project, and updates the ANSYS Workbench cell that references this 

mesh. 

  

 4. Setting Up the CFD Simulation in ANSYS FLUENT 

 Now that you have created a computational mesh for the 2D geometry, in this step 

you will set up a CFD analysis using ANSYS FLUENT, then review the list of files generated 

by ANSYS Workbench.  

 Start ANSYS FLUENT : In the ANSYS Workbench Project Schematic, double-click the 

Setup cell in the 2D fluid flow analysis system. You can also right-click the Setup cell to 

display the context menu where you can select the Edit... option. 
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Setup 

 
 When ANSYS FLUENT is first started, the FLUENT Launcher is displayed, enabling you 

to view and/or set certain ANSYS FLUENT start-up options. 

 
FLUENT Launcher display 

 

 That the Dimension setting is already filled in and cannot be changed, since ANSYS 

FLUENT automatically sets it based on the mesh or geometry for the current system. 

 - Make sure that Serial from the Processing Options list is enabled. 

 - Make sure that the Display Mesh After Reading, Embed Graphics Windows, and 

Workbench Color Scheme options are enabled. 

 - Make sure that the Double Precision option is disabled. 

Click OK to launch ANSYS FLUENT. 
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The mesh is automatically loaded and displayed in the graphics window by default 

 
The ANSYS FLUENT Application 

4.1. Set some general settings for the CFD analysis. 

 General 

 
 That the ANSYS Meshing application automatically converts and exports meshes for 

ANSYS FLUENT using meters (m) as the unit of length regardless of what units were used to 

create them. This is so you do not have to scale the mesh in ANSYS FLUENT under ANSYS 

Workbench. 
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 Check the mesh. 

 General  Check 

 ANSYS FLUENT will report the results of the mesh check in the console. 
 Domain Extents: 
     x-coordinate: min (m) = 0.000000e+00, max (m) = 1.000000e+00 
     y-coordinate: min (m) = 0.000000e+00, max (m) = 1.000000e+00 
  Volume statistics: 
     minimum volume (m3): 6.249988e-04 
     maximum volume (m3): 6.250018e-04 
      total volume (m3): 1.000000e+00 
 Face area statistics: 
     minimum face area (m2): 2.499998e-02 
     maximum face area (m2): 2.500004e-02 
  Checking mesh......................... 
 Done. 

 The minimum and maximum values may vary slightly when running on different 

platforms. The mesh check will list the minimum and maximum x and y values from the 

mesh in the default SI unit of meters. It will also report a number of other mesh features 

that are checked. Any errors in the mesh will be reported at this time. Ensure that the 

minimum volume is not negative as ANSYS FLUENT cannot begin a calculation when this is 

the case. 

4.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 
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4.3. Set up your materials for the CFD simulation. 

Materialsdouble-clicking airInsert propertiesChange/CreateClose 

 

Material properties : Density (kg/m3) =  100 

     : Viscosity (kg/m-s) = 1   This setting is for the flow condition of Re=100 

4.4. Set up the boundary conditions for the CFD analysis. 

 Boundary ConditionsMoving wallEdit 

Set : Wall Motion Moving Wall 

 : Speed (m/s)  1  Click OK 
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4.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ● Solution Methods :  Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization: Pressure : Standard 

    Momentum : First Order Upwind 

  ● Solution Controls :  Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for Pressure,  

    Density, Body force, and Momentum, respectively. 

       

 ● MonitorsResiduals 

    

 - Make sure that Plot is enabled in the Options group box. 

 - Keep the default values for the Absolute Criteria of the Residuals, as shown in     

   the Residual Monitors dialog box. 

 -  Click OK to close the Residual Monitors dialog box. 



46 
 
 ● Solution InitializationInitialize 

   

 5. Run Calculation 

    - Number of Iterations : 2000 

    - Reporting Interval : 10 

    - Profile Update Interval : 10 

    - Click Calculate 

  

- All are initialized with 0 

- Click Initialize  
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 As the calculation progresses, the surface monitor history will be plotted in the 

graphics window 

  
graphics window 

 The solution will be stopped by ANSYS FLUENT when the residuals reach their 

specified values or after 2000 iterations. The exact number of iterations will vary depending 

on the platform being used. An Information dialog box will open to alert you that the 

calculation is complete. Click OK in the Information dialog box to proceed.  

 5. Displaying Results in ANSYS FLUENT and CFD-Post 

 Start CFD-Post : In the ANSYS Workbench Project Schematic, double-click the 

Results cell in the 2D fluid flow analysis system. This displays the CFD-Post application. You 

can also right-click the Results cell to display the context menu where you can select the 

Edit... option. 
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The Elbow Geometry Loaded into CFD-Post 

 ● Displaying Vectors.  

 

  - Insert a vector object using the Insert menu item at the top of the CFD-Post window.        

    Insertvector  

  - Keep the default name of the vector (Vector 1) and click OK to close the dialog              

    box. This displays the Details of Vector 1 view below the Outline view. 

  - In Geometry Tab Select All Domains in the Domains list.  

  - Select symmetry 1 in the Locations list. 

  - Select Velocity in the Variable list. 

  - Select Normalize Symbol in Symbol Tab. 

  - Click Apply. 
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 ● Displaying Contour. 

 

  - Insert a contour object using the Insert menu item at the top of the CFD-Post window. 

    InsertContour 

    This displays the Insert Contour dialog box. 

  - Keep the default name of the contour (Contour 1) and click OK to close the dialog box. 

    This displays the Details of Contour 1 view below the Outline view in CFD-Post. This       

    view contains all of the settings for a contour object. 

  - In the Geometry tab, select All Domains in the Domains list. 

  - Select symmetry 1 in the Locations list. 

  - Select Velocity in the Variable list. 

  - # of Contours : 20 

  - Click Apply.  

 
Contour # of Contours : 20 and 1000 
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 ● Displaying Streamlines.  

 

  - Insert a streamline object using the Insert menu item at the top of the CFD-Post window. 

    InsertStreamline 

  - Keep the default name of the streamline (streamline 1) and click OK to close the dialog     

    box. This displays the Details of streamline 1 view below the Outline view in CFD-Post.   

    This view contains all of the settings for a streamline object. 

  - In the Geometry tab, select Surface Streamline in the Domains list. 

  - Select symmetry 1 in the Surfaces list. 

  - Select Velocity in the Variable list. 

  - # of points : 80 

  - Click Apply.  

 

Streamlines 
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 ● Displaying XY-Plot (Section Plot).  

 This displays the results at any desired section plane/line. In this case the x-

velocities at the haft section lines of x=0.5 of the cavity are displayed versus the y-

coordinates. 

           1. Define section plane/line : 

      SurfaceLine/Rank… 

      - End Points: x0(m)0.5, x1(m)0.5 

             y0(m) 0, y1(m) 1 

      - New Surface Name: line-1 

      - Click CreateClose 

           2. XY-Plot : 

      PlotXY Plot 

      - Options: Node Values (Enabled) 

      - Position on Y Axis (Enabled) 

      - Plot Direction: X0, Y1, Z0 

      - Y Axis Function: Direction Vector 

      - X Axis Function: Velocity X Velocity 

      - Surfaces: Select line-1 

      - Click Plot. 

3. Write Data to File : 

 1. PlotXY Plot 

  - Options: Write to File (Enabled) 

  - Click Write. 

 2. In Select File dialog boxXY File: Cavity_Re1000_G40_UDS1.xyOK 
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 ● Finding Grid Independent 

 Concept of grid independent is to find a coarse grid which gives an accuracy as same 

as a finer one. 

     1. Repeat the case with the finer grid of 80x80 

         and then write the data to file 

         Cavity_Re1000_G80_UDS1.xy 

     2. Repeat the case with the more finer one of 

         160x160 and also write the data to file 

         Cavity_Re1000_G160_UDS1.xy 

     3. PlotXY Plot… 

         - Options: Node Values (Enabled) 

         - Position on Y Axis (Enabled) 

          - Write to File (Disabled) 

         - Plot Direction: X0, Y1, Z0 

         - Y Axis Function : Direction Vector 

         - X Axis Function : VelocityX Velocity 

         - Surfaces: Select line-1 

         - Click Load FilesSelect three Files of 

Cavity_Re1000_G40_UDS1.xy, Cavity_Re1000_G80_UDS1.xy, and 

Cavity_Re1000_G160_UDS1.xy 

- Click Plot. 
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 ● Comparing Numerical Scheme 

  Calculation of 2nd Oder Accuracy:  

 Repeat the case with using 40x40 mesh  

  1. Solution Methods :   

      - Pressure-Velocity Coupling : SIMPLE 

      - Spatial Discretization: Pressure : Standard 

  - Momentum : Second Order Upwind 

 2. Run CalculationCalculate 

 3. PlotXY Plot 

  - Options: Write to File (Enabled) 

  - Click Writ 

  - In Select File dialog boxXY File:   Cavity_Re1000_G40_UDS2.xyOK 
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 ● Comparing Results with 1st Oder Accuracy: 

 4. PlotXY Plot 

    - Options: Write to File (Disabled) 

      - Surfaces: Select line-1 

     - Click Load FilesSelect three files of  Cavity_Re1000_G40UDS1.xy , 

    CavityRe1000Ghai.xy, Cavity_Re1000_G40_UDS2.xy, 

      - Click Plot.  
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 Case A2: Channel Flow 

Problem Specification 

Specification: 

   - Fluid flowing through a channel of constant cross-section and exhausts into the ambient   

     atmosphere at a pressure of p=1 atm. 

   - The channel height H=0.2 m and length L=8 m. 

   - The uniform inlet velocity Uin=1 m/s 

   - The fluid density ρ=1 kg/m3 and viscosity μ=2x10-3 kg/(ms) 

   - Reynolds number based on channel height can be calculated from 

     Re= ρUinH/μ =100 

 
 

     

 Determine the centerline velocity, wall skin friction coefficient, and velocity profile 

at the outlet (fully develop profile) compare with exact solution 

 Exact solution : 

   u(y) = ଷ୙ୌ
୦
൤1 − ቀ௬

௛
ቁ
ଶ
൨ 

 where h=H/2 and y is the distant measure from centerline to wall 

Uin=1 m/s, ρ=1 kg/m3, μ=2x10-3 kg/(ms) 

 
p=1 atm H=0.2 

L = 8 m 

Boundary layer 

Entrance region Fully develop region 

u(y
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 Boundary conditions 

 

 1. Creating Geometry 

 Click the Draw menu in the Sketching Toolboxes, and then select Rectangle.draw 

the Rectangle by first clicking on the coordinate origin, and then move the cursor obliqueto 

create Rectangle(0.2x8 m). You can setting dimension by selectYou can setting dimension by 

select Dimensions on Sketching Toolbox. 

 

Pressure outlet 
Fixed wall 

Velocity inlet 

Full Domain 
H y 

x 

L = 8 

Velocity inlet Pressure outlet Symmetry 

y 
x 

Fixed wall 

Haft Domain h = H/2 
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 Now we create a surface body Click Concept  Surfaces  From Sketches. 

 

 Select the Base Objects to Sketch1, and click Apply. 

 

 And then click Generate button above the Graphics window. 
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 2. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 

That the geometry we just created is automatically loaded. 

 

 Set some basic meshing parameters for the ANSYS Meshing application :Then using 

edge selector  

Create Mesh Edge 

1. Press Ctrl on keyboard Left click select left and right edge and right clicking   

InsertSizing. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 25 

  Bias Type :   

  Bias Factor :4 
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  left edge    right edge 

2. Repeat for the top edge  

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 125 

  Bias Type :   

  Bias Factor :4 

3. Repeat for the bottom edges 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 125 

  Bias Type :   

  Bias Factor :4 

 
Mesh edge obtained from the steps 

Create Mesh Face 

4. Right click on Mesh inOutline box Select InsertMethod 

 ●Details of "Automatic Method"-Method dialog box  

  Select Geometry and click Apply. 

  Method : Uniform Quad 

  Element Size : 1 
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5. Now you can create Mesh by right clicking Mesh in Outline Box select Generate Mesh or 

click Generate Mesh on Menu bar . 

 
Mesh face obtained from the process 

 Create named selections for the geometry boundaries :Right-click edge and select 

the Create Named Selection option. 

 ●Selection Name dialog box. 

  Top Edge : Wall 

  Bottom Edge : Wall  

  Left Edge : Velocity Inlet  

  Right Edge : Pressure Outlet 

6. Click Update on menu bar to update mesh and boundary condition  

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 

 
The ANSYS FLUENT Application 
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3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Pressure Based 

  Time : Steady 

  Velocity Formulation : Absolute 

  2D Space : Planar 

3.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) :100 

  Viscosity (kg/m-s) :0.2 This setting is for the flow condition of Re=100 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones: left click on name Velocity inlet. 

  Velocity Magnitude (m/s): 1 

  Click OK 

 ●Zones: left click on name Pressure outlet. 

  Gauge Pressure (Pascal): 0 

  Click OK 

3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization: Pressure : Standard 

    Momentum :Second Order Upwind 

 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

               Pressure, Density, Body force, and Momentum,   

               respectively. 
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 ●MonitorsResiduals 

  - Make sure that Plot is enabled in the Options group box. 

  - Keep the default values for the Absolute Criteria of the Residuals, 

 as shown in the Residual Monitors dialog box. 

  -  Click OK to close the Residual Monitors dialog box 

. ● Solution InitializationInitialize 

  - Initialization Method :Standard Initialization 

  - All are initialized with 0 

  - Click Initialize 

4. Run Calculation 

  - Number of Iterations: 2000 

  - Reporting Interval: 10 

  - Profile Update Interval : 10 

  - Click Calculate 

 
graphics window 
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5. Displaying Results in ANSYS FLUENT and CFD-Post 

 ● Displaying Vectors. 

  Insertvector  

 Keep the default name of the vector (Vector1) and click OK to close the dialog 

 box. This displays the Details of Vector 1view below the Outline. 

 - In Geometry Tab Select All Domains in the Domains list.  

 - Select symmetry 1 in the Locations list. 

 - Select Velocity in the Variable list. 

 - Symbol : 0.2 in Symbol Tab. 

  - Click Apply. 

 
 

 ● Displaying Contour. 

  InsertContour 

 Keep the default name of the contour (Contour 1) and click OK to close the dialog 

box. This displays the Details of Contour 1 view below the Outline view in CFD-Post. This 

view contains all of the settings for a contour object. 

 - In the Geometry tab, select All Domains in the Domains list. 

 - Select symmetry 1in the Locations list. 

 - Select Velocity in the Variable list. 

 - # of Contours :30 

 - Click Apply. 
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 ●Fully Develop Profile at Outlet. 

 This displays the results of velocity profile at exit plane. In this case the x-velocities 

at the exit section lines of x=8 of the channel are displayed versus the y-coordinates. 

  x-y Plot of the velocity profile at exit plane: 

  PlotXY Plot 

      - Options: Node Values (Enabled) 

      - Position on Y Axis (Enabled) 

      - Plot Direction: X1, Y0, Z0 

      - Y Axis Function: Direction Vector 

      - X Axis Function: VelocityX Velocity 

      - Surfaces: Select outlet 

      - Click Plot. 

 
 

 Note 

 We can see that the maximum velocity at the midline is approached to 1.5 at 

the exit plane. 
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 Practice A1 

 Channel Flow with Haft Domain 

 According the channel flow as previous consideration. Try again with the with the 

haft domain size 

 

Results 

● Displaying Vectors. 

 

● Displaying Contour. 

 

●Fully Develop Profile at Outlet. 
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 Case A3: Backward Facing Step Flow 

Problem Specification 

Specification: 

 - Fluid flowing in a channel with suddenly change in area cross-section 

 - The haft channel height H=0.1 m and length L=1 m. 

 - The uniform inlet velocity Uin=1 m/s  The fluid density ρ=200 kg/m3  

   and viscosity μ=0.1 kg/(ms) 

 - The Reynolds number based on channel height can be calculated from 

      Re= ρUinH/μ =200 

Note 

For Re=600 with L=1, we can see areversed flow at the exit of the channel. This 

isbecause the channel length is not long enoughto generate the fully develop profile of the 

flow.The reverse flow usually gives an unstablecondition for the computation. 

 
Determine a reattachment point of the flow with Reynolds numbers of 200 and 600 

 

 

 

 

Uin 
h=H/2 H=0.1 m 

L=1 m 

Reattachment point 

Velocity inlet Symmetry Outlet 

Wall 
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 1. Creating Geometry 

 Click the Draw menu in the Sketching Toolboxes, and then select Line. Draw the 

Rectangle. You can setting dimension by select setting dimension by select Dimensions on 

Sketching Toolbox. 

 

 Now we create a surface body Click Concept  Surfaces FromSketches. 

 

 Select the Base Objects to Sketch1, and click Apply. 
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 And then click Generate button above the Graphics window. 

 

 2. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 

 That the geometry we just created is automatically loaded. 

 

Set some basic meshing parameters for the ANSYS Meshing application :Then using 

edge selector  
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Create Mesh Edge 

1. Press Ctrl on keyboard Left click right edge and right clickingInsertSizing. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions :5 

  Bias Type :No Bias  

 

2. Repeat for the top edge. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 100 

  Bias Type :   

  Bias Factor :4 

3. Repeat for the bottom edges. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 125 

  Bias Type :   

  Bias Factor :4 
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4. Repeat for the left edges. (2 line) 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

      Number of Divisions : 10 

  Bias Type :No Bias  

 

Create Mesh Face 

5. Right click on Mesh inOutline box Select InsertMethod 

 ●Details of "Automatic Method"-Method dialog box  

  Select Geometry and click Apply. 

  Method :Triangles 

6. Now you can create Mesh by right clicking Mesh in Outline Box select Generate Mesh or 

click Generate Mesh on Menu bar . 

 

Create named selections for the geometry boundaries : Right-click edge and select 

the Create Named Selection option. 

 ●Selection Name dialog box. 

  Top Edge :Symmetry 

  Bottom Edge and Left(bottom) Edge : Wall  

  Left(top) Edge : Velocity Inlet  

  Right Edge (Outlet) :Outflow 
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7. Click Update on menu bar to update mesh and boundary condition  

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 

 
The ANSYS FLUENT Application 

3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Pressure Based 

  Time : Steady 

  Velocity Formulation : Absolute 

  2D Space : Planar 
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3.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) :200 

  Viscosity (kg/m-s) : 0.1   This setting is for the flow condition of Re=200 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones : left click on name Velocity inlet. 

  Velocity Magnitude (m/s) : 1 

  Click OK 

 ●Zones : left click on name Outflow. 

  Flow Rate Weighting: 1 

  Click OK 

3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization: Pressure : Standard 

    Momentum : Second Order Upwind 

 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

    Pressure, Density, Body force, and Momentum,   

    respectively. 

 ●MonitorsResiduals 

  - Make sure that Plot is enabled in the Options group box. 

  - Keep the default values for the Absolute Criteria of the Residuals, 

 as shown in the Residual Monitors dialog box. 

  -  Click OK to close the Residual Monitors dialog box. 
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 ● Solution InitializationInitialize 

  - Initialization Method :Standard Initialization 

  - All are initialized with 0 

  - Click Initialize 

4. Run Calculation 

  - Number of Iterations: 2000 

  - Reporting Interval: 10 

  - Profile Update Interval : 10 

  - Click Calculate 

5. Displaying Results in ANSYS FLUENT and CFD-Post 

● Displaying Contour. 

  InsertContour 

 Keep the default name of the contour (Contour 1) and click OK to close the dialog 

box. This displays the Details of Contour 1 view below the Outline view in CFD-Post. This 

view contains all of the settings for a contour object. 

 - In the Geometry tab, select All Domains in the Domains list. 

 - Select symmetry 1in the Locations list. 

 - Select Velocity in the Variable list. 

 - # of Contours : 30 

 - Click Apply. 

 
Contour of the velocity magnitude 
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● Displaying Streamlines. 

  - Insert a streamline object using the Insert menu item at the top of the CFD-Post window. 

InsertStreamline 

  - Keep the default name of the streamline (streamline 1) and click OK to close the dialog 

box. This displays the Details of streamline 1 view below the Outline view in CFD-Post.  

This view contains all of the settings for a streamline object. 

  - In the Geometry tab, select Surface Streamline in the Domains list. 

  - Select symmetry 1in the Surfaces list. 

  - Select Velocity in the Variable list. 

  - # of points :100 

  - Click Apply. 

 
Streamlines the velocity magnitude 

● Contour plot of pressure: 

 DisplayContours 

  - Contour of: Total Pressure 

  - Options: Filled (Selected) 

  - Levels: 20 

  - Setup: 1 

 
Contour of Total Pressure 
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● Contour plot of Wall Fluxes: 

 DisplayContours 

  - Contour of: Wall FluxesSkin Friction Coefficient  

  - Options: Filled (Selected) 

  - Levels: 20 

  - Setup: 1 

          
Contour of Wall Fluxes in term of Skin friction Coefficient 

● Effect of Numerical Schemes 
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 Practice A2 

 Flow over a Car Model 

Specification: 

 - Car model with dimensioning size as shown in the figure is running with a   

              constant speed of 56 km/h. 

 - The fluid density ρ =1.2 kg/m3 and viscosity μ=1x10-5 kg/(ms) 

 - Determine the domain size for simulating the flow problem here. 

 - Simulate the flow behavior over the model car with above flow conditions. 

 

 
Car Dimension 
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Boundary Condition 
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Results 

● Displaying Streamline 

 

 

 

 
Streamline of Velocity 

 
Contours of Velocity 

 
Contours of Pressure 

 Scheme: 2nd Order Upwind 

 Drag: 276 N 
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 Case A4: Flow around a Cylinder 

Problem Specification 

 

 

Regimes of flow in steady current 

 

No separation, creeping flow Re < 5 

 

A fixed pair of symmetric 

vortices 

5 < Re < 40 

 

 

Laminar vortex street 40 < Re < 200 

 

 

Transition to turbulence in 

the wake 

200 < Re < 300 

 

Wake completely turbulent. 

A: Laminar boundary layer 

separation 

300 < Re < 3x105 
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 Consider the steady state case of a fluid flowing past a cylinder, as illustrated above. 

Obtain the velocity and pressure distributions when the Reynolds number is chosen to be 30 

In order to simplify the computation 
 - The cylinder diameter of D=0.1 m 

 - The uniform inlet velocity Uin=1 m/s  The fluid density ρ=30 kg/m3  

   and viscosity μ=0.1 kg/(ms) 

 - The Reynolds number based on channel height can be calculated from 

      Re= ρUinH/μ =30 

 Note 

 - Determine the flow field behavior at Reynolds number of 30 

 - Observe the distribution of pressure field around the cylinder 

 

 
 

 

Free stream 
Inlet 

H 
Wall 

L1 L2 

Free stream 

O
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 1. Creating Geometry 

 Create a circle, centered around the origin in the xy plane. Set the diameter of the 

circle to 0.1 m. And Create a rectangular follow the picture.  

 

 

 

Now we create a surface body Click Concept  Surfaces From Sketches. 
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 Select the Base Objects to Sketch1, and click Apply. 

 

 And then click Generate button above the Graphics window. 

 

 2. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 
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 That the geometry we just created is automatically loaded. 

 

Create Mesh Edge 

1. Press Ctrl on keyboard Left click left edge and right clickingInsertSizing. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 20 

  Bias Type :  

  Bias Factor : 5 

2. Repeat for the top and bottom edge. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 20 

  Bias Type : No Bias  

3. Repeat for the right edge. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 10 

  Bias Type : No Bias 
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4. Repeat for the circle edge. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 40 

  Bias Type : No Bias  

 

Create Mesh Face 

5. Right click on Mesh inOutline box Select InsertMethod 

 ●Details of "Automatic Method"-Method dialog box  

  Select Geometry and click Apply. 

  Method :Triangles 

6. Now you can create Mesh by right clicking Mesh in Outline Box select Generate Mesh or 

click Generate Mesh on Menu bar . 

 

Create named selections for the geometry boundaries : Right-click edge and select 

the Create Named Selection option. 
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 ●Selection Name dialog box. 

  Top and Bottom Edge :Symmetry 

  Circle edge : Wall 

  Left Edge : Velocity Inlet  

  Right Edge (Outlet) :Outflow 

 

7. Click Update on menu bar to update mesh and boundary condition  

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 

 
The ANSYS FLUENT Application 
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3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Pressure Based 

  Time : Steady 

  Velocity Formulation : Absolute 

  2D Space : Planar 

3.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) : 30 

  Viscosity (kg/m-s) :0.1 This setting is for the flow condition of Re=30 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones : left click on name Velocity inlet. 

  Velocity Magnitude (m/s) : 1 

  Click OK 

 ●Zones : left click on name Outflow. 

  Flow Rate Weighting: 1 

  Click OK 

3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization : Pressure : Standard 

    Momentum : Second Order Upwind 
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 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

    Pressure, Density, Body force, and Momentum,   

    respectively. 

 ●MonitorsResiduals 

  - Make sure that Plot is enabled in the Options group box. 

  - Keep the default values for the Absolute Criteria of the Residuals, 

 as shown in the Residual Monitors dialog box. 

  -  Click OK to close the Residual Monitors dialog box. 

 ● Solution InitializationInitialize 

  - Initialization Method : Standard Initialization 

  - All are initialized with 0 

  - Click Initialize 

 4. Run Calculation 

  - Number of Iterations: 2000 

  - Reporting Interval: 10 

  - Profile Update Interval : 10 

  - Click Calculate 

 5. Displaying Results  

● Displaying Streamlines. 

 Graphics and AnimationsPath lines 

  - Style : line 

  - Color by : Velocity Magnitude 

  - Step Size (m) : 0.01 

  - Steps : 20 

  - Path Skip : 3 

  - Release from Surfaces : Select All 

  - Click Display 
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● Displaying Contour of Velocity. 

 Graphics and AnimationsContours 

  - Contour of : Velocity Magnitude 

  - Options : Filled (Selected) 

  - Levels : 20 

  - Setup : 1 

 

● Displaying Contour of Static Pressure. 

 Graphics and AnimationsContours 

  - Contour of : Static pressure 

  - Options : Filled (Selected) 

  - Levels : 20 

  - Setup : 1 

Stagnation points Separation points 

Circulation zone 



88 
 

 

● Pressure Distribution along Curve: 

 PlotXY Plot 

  - Options : Node Value (Enabled) 

  - Options : Position on X Axis (Enabled) 

  - Y Axis Function : Static Pressure 

  - X Axis Function : Curve Length 

  - Surfaces : circle 

 

 

A 

B D 

C 

Stagnation points 

A 

B (Stagnation) 

C 

D D 
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 Practice A3 

Flow over a Circular Tube Prattle 

 

 

Specification : 

 - The cylinder diameter of D=0.1 m and space H=D 

 - The uniform inlet velocity Uin=1 m/s 

 - The fluid is air with a density ρ =30 kg/m3 and viscosity μ=0.1 kg/(ms) 

 - Reynolds number of the flow can be calculated by Re= ρUinH/μ=30 

Result 

 

Symmetry 

H 

Stream lines 

Pressure Contour 
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 Practice A4 

Flow around a Rotating Cylinder 

 

Specification : 

 - The cylinder with diameter of D=0.1m is rotated clockwise with a constant angular  

   velocity  is -10 rad/s (CW) 

 - The uniform inlet velocity Uin=1 m/s 

 - The fluid is air with a density ρ =20 kg/m3 and viscosity μ=0.1 kg/(ms) 

 - Reynolds number of the flow can be calculated by Re= ρUinH/μ=20 

 

 Note 

  - Determine the flow field behavior at Reynolds numbers of 20 

  - Observe the distribution of pressure around upper and lower surface of  

    the cylinder and then compare the result with case A5 

● Setting Control Parameters 

      

            Click Edit 

      Wall Motion: Moving Wall 

      Motion  : Rotational 

       : Speed(rad/s)= -10 

       : Rotational-Axis Origin X(m)=0,  

         Y(m)=0 

            Click OK 
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Result 

 
Streamlines 

 
Pressure Contour 

 

 

 

 

 

 

Stagnation points 
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 Case A5: Flow around an Airfoil NACA0012 

Problem Specification 

 In this tutorial, we will show you how to simulate a NACA 0012 Airfoil at a 6 degree 

angle of attack placed in a wind tunnel. Using FLUENT, we will create a simulation of this 

experiment. Afterwards, we will compare values from the simulation and data collected from 

experiment. 

 

 
 

 1. Creating Geometry 

 ● Download the Airfoil Coordinates 

 In this step, we will import the coordinates of the airfoil and create the geometry we 

will use for the simulation. Begin by downloading this file coordinates of the airfoil NACA 

0012.  

 ● Launch Design Modeler 

 Before we launch the design modeler, we need to specify the problem as a 2D 

problem. Right click  and select Propert ies . Select Analysis Type 

2D . Now, double click  to launch the Design Modeler. When 

prompted, select Meters as the unit of measurement. 
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 ● Creating Airfoil 

 First, we will create the geometry of the airfoil. In the menu bar, go to Concept > 

3D Curve. In the Details View window, click Coordinates File  and select the 

ellipsis  to browse to a file. Browse to and select the geometry file you downloaded 

earlier. Once you have selected the desired geometry file, click  to create the 

curve. Click  to get a better look at the curve. 

 

 Next, we need to create a surface from the curve we just generated. Go 

to Concepts > Surfaces from Edges. Click anywhere on the curve you just created, and 

select Edges > Apply in the Details View Window. Click  to create the surface. 
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 2. Meshing the Geometry in the ANSYS Meshing Application 
 ● Create C-Mesh Domain 

 Now that the airfoil has been generated, we need to create the meshable surface 

we will use once we begin to specify boundary conditions. We will begin by creating a 

coordinate system at the tail of the airfoil - this will help us create the geometry for the C-

mesh domain. Click  to create a new coordinate system. In the Details View window, 

select Type > From Coordinates . For FD11, Point X , enter 1. 

 

 Click  to generate the new coordinate system. In the Tree 

Outline Window, select the new coordinate system you created (defaulted to Plane 4), 

then click  to create a new sketch. This will create a sketching plane on the XY plane 

with the tail of the airfoil as the origin. At the bottom of the Tree Outline Window, click 

the Sketching tab to bring up the sketching window. 
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 The first action we will take is create the arc of the C-Mesh domain. 

Click . The first click selects the center of the arc, and the next two clicks 

determine the end points of the arc. We want the center of the arc to be at the tail of the 

airfoil. Click on the origin of the sketch, making sure the P symbol is showing 

 

 For the end points of the arc, first select a point on the vertical axis above the origin 

(a C symbol will show), then select a point on the vertical axis below the origin. You should 

end up with the following  

 

 To create the right side of the C-Mesh domain, click . Click 

the following points to create the rectangle in this order - where the arc meets the positive 

vertical axis, where the arc meets the negative vertical axis, then anywhere in the right half 

plane. The final result should look like this 
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 Now, we need to get rid of necessary lines created by the rectangle. 

Select Modify in the Sketching Toolboxes window, then select . Click the 

lines of the rectangle they are collinear with the positive and negative vertical axises.  

 Now, select the Dimensions toolbox to dimension the C-Mesh domain.  

 - Assign the arc a value of 12.5. Next,  

 - vertical axis and the vertical portion of the rectangle in the right half plane. Also 

assign the horizontal dimension a value of 12.5. 
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 Next, we need to create a surface from this sketch. To accomplish this, go 

to Concept > Surface From Sketches. Click anywhere on the sketch, and select Base 

Objects > Apply in the Details View Window. Also, select Operation > Add Frozen. 

Once you have the correct settings, click . The final step of creating the C-Mesh is 

creating a surface between the boundary and the airfoil. To do this, go to Create > Boolean. 

In the Details View window, select Operation > Subtract. Next, select Target Bodies > 

Not selected, select the large C-Mesh domain surface, then click Apply. Repeat the same 

process to select the airfoil as the Tool Body. When you have selected the bodies, 

click . 

 

 ● Create Quadrants 

 In the final step of creating the geometry, we will break up the new surface into 4 

quadrants; this will be useful for when we want to mesh the geometry. To begin, 

select Plane 4 in the Tree Outline Window, and click . Open the sketching menu, and 

select . Draw a line on the vertical axis that intersects the entire C mesh. Trim 

away the lines that are beyond the C-Mesh, and you should be left with this 
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 Next, go to Concepts > Lines from Sketches. Select the line you just drew and 

click Base Objects > Apply, followed by . Now that you have created a vertical 

line, create a new sketch and repeat the process for a horizontal line that is collinear to 

horizontal axis and bisects the geometry. 

 

 Now, we need to project the lines we just created onto the surface. Go to Tools > 

Projection. Select Edges press Ctrl and select on the vertical line we drew (you'll have to 

select both parts of it), then press Apply. Next, select Target and select the C-Mesh 

surface, then click Apply. 

 Once you click , you'll notice that the geometry is now composed of two 

surfaces split by the line we selected. Repeat this process to create 2 more projections: one 

projection the line left of the origin onto the left surface, and one projecting the right line on 

the right surface. When you're finished, the geometry should be split into 4 parts.  
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 The geometry is finished. Save the project and close the design modeler, as we are 

now we are ready to create the mesh for the simulation. 

 2. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 

That the geometry we just created is automatically loaded. 
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Create Mesh Edge 

1. Press Ctrl on keyboard Left click 4 edge and right clickingInsertSizing. 

 ●Details of "Edge Sizing"-Sizing dialog box  

  Type : Number of Divisions 

  Number of Divisions : 50 

  Behavior : Hard 

  Bias Type :  

  Bias Factor : 150 

 

2. Repeat for 4 edge (see figure below). 

  Type : Number of Divisions 

  Number of Divisions : 50 

  Behavior : Hard 

  Bias Type :  

  Bias Factor : 150 
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3. Repeat for C edge (see figure below). 

  Type : Number of Divisions 

  Number of Divisions : 100 

  Behavior : Hard 

 
Create Mesh Face 

4. In the Meshing Toolbar, select  

 ● Mesh Control > Mapped Face Meshing. select all four faces by holding down 

the right mouse button and dragging the mouse of all of the quadrants of the geometry. 

When all of the faces are highlighted green, in the Details view Window select Geometry 

> Apply. 

 ●Mesh Control > Method select all four faces. In the Details view Window 

select Geometry > Apply. 

  - Method : Uniform Quad 

  - Element Size : 1 m 

5. Now you can create Mesh by right clicking Mesh in Outline Box select Generate Mesh or 

click Generate Mesh on Menu bar . 
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Create named selections for the geometry boundaries : Right-click edge and select 

the Create Named Selection option. 

 

 ●Selection Name dialog box. 

  Top ,Bottom and C Edge :  Velocity inlet 

  Airfoil : Wall 

  Right Edge (Outlet) : Pressure outlet 
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6. Click Update on menu bar to update mesh and boundary condition  

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 

 

  Fluent Launcher Window should open. Check the box marked Double 

Precision . To make the solver run a little quicker, under Processing Options we will 

select Parallel and change the Number of Processes to 2. This will allow users with a 

double core processor to utilize both. 
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3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Densuty Based 

  Time : Steady 

  Velocity Formulation : Absolute 

  2D Space : Planar 

3.2. Set up your models for the CFD simulation. 

 ModelsViscousInviscidOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) : 1 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones : left click on name Velocity inlet. 

  Velocity Specification Method : Components.  

  X-Velocity (m/s) : 0.9945 

  Y-Velocity (m/s) : 0.1045 

  Click OK 

 ●Zones : left click on name Outlet. : Pressure Outlet 

  Gauge Pressure : 1 

  Click OK 

3.5. Set up Reference Values for the CFD simulation. 

  Compute form : inlet 

3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization : Pressure : Standard 

    Momentum : Second Order Upwind 
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 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

    Pressure, Density, Body force, and Momentum,   

    respectively. 

 ●MonitorsResiduals 

  - Make sure that Print, Plot is enabled in the Options group box. 

  - Absolute Criteria : 1x10-6 

  - Click OK to close the Residual Monitors dialog box. 

 

 ● Solution InitializationInitialize 

  - Initialization Method : Standard Initialization 

  - Compute form : inlet 

  - Click Initialize 

 4. Run Calculation 

  - Number of Iterations: 2000 

  - Reporting Interval: 10 

  - Profile Update Interval : 10 

  - Click Calculate 

 

 

 

 



106 
 
 5. Displaying Results  

● Displaying Streamlines. 

 Graphics and AnimationsPathlines 

  - Style : line 

  - Color by : Velocity Magnitude 

  - Step Size (m) : 50 

  - Steps : 20 

  - Path Skip : 3 

  - Release from Surfaces : Select All 

  - Click Display 

 

● Displaying Contour of Velocity. 

 Graphics and AnimationsContours 

  - Contour of : Velocity Magnitude 

  - Options : Filled (Selected) 

  - Levels : 20 

  - Setup : 1 
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● Displaying Contour of Static Pressure. 

 Graphics and AnimationsContours 

  - Contour of : Static pressure 

  - Options : Filled (Selected) 

  - Levels : 20 

  - Setup : 1 

 

● Pressure Coefficient 

 PlotXY Plot 

      - Options : Node Values (Enabled),   Position on X Axis (Enabled) 

      - Plot Direction: X0, Y1, Z0 

      - Y Axis Function: PressurePressure Coefficient 

      - X Axis Function: Direction Vector 

      - Surfaces : Airfoil 

      - Click Plot. 
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● Coefficients of Lift and Drag 

 ReportsForce  

  - Drag Coefficients  X = 0.9945 

      Y = 0.1045 

  - Click Print 

 

  - Lift Coefficients X = -0.1045 

      Y = 0.9945 

  - Click Print 
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 Case A6: Unsteady Flow Simulation 

Flow around a Cylinder 

Problem Specification 

 

 

 Consider the unsteady state case of a fluid flowing past a cylinder, as illustrated 

above  Obtain the velocity and pressure distributions when the Reynolds number is chosen 

to be 30 In order to simplify the computation 

 - The cylinder diameter of D=0.1 m 

 - The uniform inlet velocity Uin=1 m/s  The fluid density ρ=200 kg/m3  

   and viscosity μ=0.1 kg/(ms) 

 - The Reynolds number based onchannel height can be calculated from 

      Re= ρUinH/μ =200 

 1. Creating Geometry 

 We can skip the geometry step, because it is the same as the "Steady Flow Past a 

Cylinder" geometry and we have already duplicated that project.  
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 2. Meshing the Geometry in the ANSYS Meshing Application 

 We can skip the mesh step as well, because it is the same as the "Steady Flow Past 

a Cylinder" mesh and we have already duplicated that project.  

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Launch FLUENT.(Double Click) Setup. Then click OK 

 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 

 
The ANSYS FLUENT Application 

 



111 
 
3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Pressure Based 

  Time : Transient 

  Velocity Formulation : Absolute 

  2D Space : Planar 

 

3.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) : 200 

  Viscosity (kg/m-s) :0.1 This setting is for the flow condition of Re=200 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones : left click on name Velocity inlet. 

  Velocity Magnitude (m/s) : 1 

  Click OK 

 ●Zones : left click on name Outflow. 

  Flow Rate Weighting: 1 

  Click OK 
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3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization : Pressure : Standard 

    Momentum : Second Order Upwind 

 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

    Pressure, Density, Body force, and Momentum,   

    respectively. 

 ● MonitorsResiduals 

  - Make sure that Plot is enabled in the Options group box. 

  - Keep the default values for the Absolute Criteria of the Residuals, 

 as shown in the Residual Monitors dialog box. 

  -  Click OK to close the Residual Monitors dialog box. 

 ● Solution InitializationInitialize 

  - Initialization Method : Standard Initialization 

  - Compute from : Inlet 

  - Click Initialize 

 ● SolutionCalculation ActivitiesSolution Animations 

 

 Click Create/Edit 
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 The Solution Animation dialog box appears 

  - Animation Sequences : 1 

  - Every : 5 

  - When : Time Step 

  - Click Define  (the Animation Sequence dialog box appears) 

 

 In the Animation Sequence dialog box 

  - Storage Type : Metafile 

  - Name : cylinder_unsteady 

  - Storage Directory : type a destination directory to store the data 

  - Window : 1 

  - Click Set (a new graphic window appears) 

  - Display Type: Pathlines (the Pathlines dialog box appears) 
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 In Pathlines dialog box 

  - Style : line 

  - Color by : Velocity Magnitude 

  - Step Size (m) : 0.01 

  - Steps : 20 

  - Path Skip : 3 

  - Release from Surfaces : Select interior and inlet surface 

  - Click Display and Close (The graphic displays the problem domain) 

 

4. Run Calculation 

  - Time Step Size : 1 s 

  - Number of Time Steps : 120 

  - Max Iterations/Time Step : 500 

  - Reporting Interval : 10 

  - Profile Update Interval : 10 

  - Click Calculate 
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5. Displaying Results  

 ● ResultsGraphics and AnimationsAnimationsSolution Animations 

PlaybackSet Up 

   

 Click Play   

 ● Results of Pathlines 
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Analysis of 3-D FLOW 

External Flow 

 Case B1: Flow past Dolphin 

Problem Specification 

 

 In this tutorial, we will show you how to simulate flow past Dolphin, and how to 

import geometry from solid work. when the Reynolds number is chosen to be 10000 In order 

to simplify the computation 
 - The Dolphin length of L=1.86 m 

 - The uniform inlet velocity Uin=53.7634 m/s  The fluid density ρ=10 kg/m3  

   and viscosity μ=0.1 kg/(ms) 

 - The Reynolds number based on channel height can be calculated from 

      Re= ρUinL/μ =10000 
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 1. Geometry 

Import cad file from solid work, Create a new FLUENT fluid flow analysis system by 

double-clicking the Fluid Flow (FLUENT) option under Analysis Systems in the Toolbox. 

 

Import Geometryright click on GeometryImport GeometryBrowse... 

 

Inlet 
Free stream 

Free stream 

Wall O
ut

le
t 



118 
 

 

 2. Meshing the Geometry in the ANSYS Meshing Application 

 Open the ANSYS Meshing application :To start the meshing process, right click the 

Mesh menu in the Project Schematic window and select Edit to open ANSYS Meshing. 

 
ANSYS Meshing  

 

 Tip 

 You can double-clicking the Mesh menu in the Project Schematic window to open 

ANSYS Meshing. 

 

that the geometry we just created is automatically loaded. 
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In this case we use automatic Mesh : Click Generate Mesh on Menu bar  

 

Mesh 
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 Create named selections for the geometry boundaries : Right-click the Front face 

and select the Create Named Selection option. In the Selection Name dialog box, enter 

Velocity inlet for the name and click OK.  

 
Create named selections for the geometry boundaries  

- Perform the same operations for :  Rear face  enter Outlet  for the name and click OK.  

- Perform the same operations for :  Top, Bottom, Right and left face  enter Symmetry  for 

the name and click OK.  

 

 Using the Generate Mesh option creates the mesh, but does not actually create 

the relevant mesh files for the project and is optional if you already know that the mesh is 

acceptable. Using the Update option automatically generates the mesh, creates the relevant 

mesh files for your project, and updates the ANSYS Workbench cell that references this 

mesh. 

 

 3. Setting Up the CFD Simulation in ANSYS FLUENT 

 Open Setup window. The mesh is automatically loaded and displayed in the 

graphics window by default 
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The ANSYS FLUENT Application 

3.1. Set some general settings for the CFD analysis. 

 General 

  Solver : Pressure Based 

  Time : Steady 

  Velocity Formulation : Absolute 

3.2. Set up your models for the CFD simulation. 

 ModelsViscousLaminarOK 

3.3. Set up your materials for the CFD simulation. 

 Materials air 

  Density (kg/m3) :10 

  Viscosity (kg/m-s) : 0.1   This setting is for the flow condition of Re=10000 

  Click Change/CreateClose 

3.4. Set up the boundary conditions for the CFD analysis. 

 Boundary Conditions 

 ●Zones : left click on name Velocity inlet.Edit 

  Velocity Magnitude (m/s) : 53.7634 

  Click OK 
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 ●Zones : left click on name Outlet. Edit 

  Pressure-outlet :0 

  Click OK 

3.5. Set up solution parameters for the CFD simulation. 

 Solution 

 ●Solution Methods : Pressure-Velocity Coupling : SIMPLE 

    Spatial Discretization: Pressure : Standard 

    Momentum : Second Order Upwind 

 ● Solution Controls: Under-Relaxation Factors : Use 0.3, 1, 1, 0.7 for   

    Pressure, Density, Body force, and Momentum,   

    respectively. 

 ●MonitorsResiduals 

  - Make sure that Plot is enabled in the Options group box.   

  -  Click OK to close the Residual Monitors dialog box. 

 

 ● Solution InitializationInitialize 

  - Initialization Method :Standard Initialization 

  - All are initialized with 0 

  - Click Initialize 

4. Run Calculation 

  - Number of Iterations: 2000 

  - Reporting Interval: 10 
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  - Profile Update Interval : 10 

  - Click Calculate 

 

5. Displaying Results in ANSYS FLUENT and CFD-Post 

 ● Displaying Streamlines.  

 

  - Insert a streamline object using the Insert menu item at the top of the CFD-Post window. 

    InsertStreamline 

  - Keep the default name of the streamline (streamline 1) and click OK to close the dialog     

    box. This displays the Details of streamline 1 view below the Outline view in CFD-Post.   

    This view contains all of the settings for a streamline object. 

  - In the Geometry tab, in the Domains list. Select All Domains. 
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  - In the Start From list. Select part6 dolphin 1  

  - Select Velocity in the Variable list. 

  - Max points : 300 

  - Click Apply.  

 

  

Stream line 
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